Money Smith Index

Money Smith Manual
1. Introduction to Money Smith Introduction to the Manual.
2. What's New in Money Smith 3.0 New Version 3.0 features.
3. Setting up Money Smith How to load, enter, and exit Money Smith.
4. Money Smith files How to open, close and backup Money Smith files.
5. Interactive Windows Using Interactive Windows.
6. Setting up your accounts Establishing and editing your accounts.
7. Entering Transactions Entering and editing transactions.
8. Money Smith reports Creating and printing reports.
9. Money Smith graphs Creating and printing graphs.
10. Printing Basics Printing Checks, Graphs, Reports, and Views.
11. Recurring Transactions Automate your regular bills.
12. Defining Categories Setting up account categories.
13. Investment accounts Handle stocks, mutual funds, and the like.
14. Ending the Year Rolling out transactions at the end of the year.

15. Examples and Applications Sample applications of Money Smith.

Keyboard Help:
Keyboard Help Display help on keys.

Commands:
System Commands System menu box commands.
File Commands File menu commands.
Edit Commands Edit menu commands.
View Commands View menu commands.
Options Commands Options menu commands.
Reports Commands Reports menu commands.
Graphs Commands Graphs menu commands.
Tools Commands Tools menu commands.
Window Commands Window menu commands.
Miscellaneous Commands Miscellaneous menu commands.

Dialogs:
Account Editing Dialog Account editing dialog.
Transaction Editing Dialog Transaction editing dialog.
Investment Editing Dialog Investment editing dialog.

License:
License Terms Licensing terms for Money Smith.



Command Index

Commands:
System Commands System menu box commands.
File Commands File menu commands.
Edit Commands Edit menu commands.
View Commands View menu commands.
Options Commands Options menu commands.
Reports Commands Reports menu commands.
Graphs Commands Graphs menu commands.
Tools Commands Tools menu commands.
Window Commands Window menu commands.
Miscellaneous Commands Miscellaneous menu commands.

Commands under the System menu box:
System Restore command Restore window to previous size.
System Move command Move window.
System Size command Change the size of a window.
System Minimize command Shrink window to an icon.
System Maximize command Size window to full screen.
System Close command Close window.
System Switch To command Switch to another task.
System Next command Switch to next document.
System Scrollbar Scroll the window vertically or horizontally.

Commands under the File menu:
File New command Create a new file.
File Open command Open and existing file.
File Close commandClose an open window or file.
File Save command Save current file.
File Save As command Save active window to a new file name
File Delete command Delete a file.
File Print command Set up printer.
File Printer Setup command Set up printer.
File Exit command Exit Money Smith.
File 1, 2, 3 command Directly open a previously used file.

Commands under the Edit menu:
Edit Cut command Cut an account or transaction to clipboard.
Edit Copy command Copy an account or transaction to clipboard.
Edit Paste command Paste an account or transaction from clipboard.
Edit Copy Report command Copy the entire report to the clipboard.
Edit Add command Add a new account or transaction.
Edit Edit command Edit the current account or transaction.
Edit Import Transactions command Import transactions.
Edit Find command Locate transaction or account.

Commands under the View menu:
View Account command View account list.
View Transaction command View current transactions.
View Toolbar command Toggle Toolbar on and off.
View Statusbar command Toggle Statusbar on and off.
View Grid command Toggle grid lines on and off.




Commands under the Options menu:
Options Date command Change the currently viewable date.
Options Preferences Set Money Smith preferences.
Options Report Title command Set the title for graphs and reports.
Options Password command Set or reset password for account.

Commands under the Report menu:
Report Balance Statement command Create a balance report window.
Report Income Statement command Create an income report window.
Report Budget Report command Create a budget report window.
Report Account Inflow/Outflow command Account flow report window.
Report Tax Summary command Create a tax summary report window.
Report Category command Create a balance report window.
Report Category Balance Statement command Balance statement by category.
Report Category Income Statement command Income statement by category.
Report Current Account Register command Display this accounts transaction register.
Report Reconcile Current Account command Create a reconciliation report.
Report Cash Flow for Current Account command Display account's inflows/outflows.
Report Current Investment command Create an investment window.

Commands under the Graph menu:
Graph Assets command Graph current assets.
Graph Liabilities command Graph current liabilities.
Graph Equity command Graph current equity.
Graph Income command Graph current income.

Graph Expense command Graph current expenses.
Graph One Category command Graph a single category.

Graph All Categories command Graph all categories by type.
Graph History of Account command Graph the monthly history of an account.

Graph History of Category command Graph the monthly history of a category.

Graph History of Assets,etc command Graph the monthly history of a assets, liabilities,
expenses, etc...

Graph Current Investment command Graph the current account's investment info.

Commands under the Tools menu:
Tools Financial Calculator command Run Financial Calculator.
Tools Category command Edit category list.
Tools Recurring Transactions command Edit recurring transactions.
Tools Investments command Edit invesment accounts.
Tools End of Year command Perform end of year processing.

Commands under the Window menu:
Window Tile command Tile windows in workspace.
Window Cascade command Cascade windows in workspace.
Window Arrange Icons command Arrange Icons in workspace.
Window Close All command Close all windows in workspace.
Window 1,2,3... command Activate a window.

Miscellaneous Interactive Commands:
Currency($) Display command Display pie graph with currency legends.
Percent (%) Display command Display pie graph with percentage legends.
Change Account command Switch graph of report to another account.
Smart Number Entry Fields Smart humber entry field feature description.
Mark Transaction command Mark transaction as cleared/not cleared.







Keyboard Help

Money Smith Window Keys
F1: Brings up Help Index
Shift+F1: Activates Money Smith point and shoot help
Up, Down Arrows: Move current transaction/account bar up or down.
PageUp, PageDown: Page display forward or back one screen.
Home, End: Skip to beginning or end of current display.
Enter: Edits the current account or transaction.
Delete: Deletes the current account or transaction.
Insert: Inserts a new account or transaction into the list.
F10: Moves cursor to the menu.

Dialog Keys
Tab: Moves cursor to next field.
Backtab: Moves cursor to previous dialog field.
Space: Select or deselect a pushbox or buitton.
Enter: Activates button with heavy outline - usually saving the current dialog.
Arrow Keys: Move cursor within a text field.
Alt+space: Activate system menu box in upper right corner.

Cut & Paste Keys:
Ctrl+Ins: Copy the current account or transaction to the clipboard.
Shift+Delete: Cut the current account or transaction to the clipboard.
Shift+Ins: Paste an account or transaction from the clipboard.

Function Keys
F1: Activates Money Smith Help Index
F3: Save currently active Money Smith file.
F4: Tile windows in workspace.
F5: Cascade windows in workspace.
F6: Activate next Money Smith window in workspace.
F10: Moves cursor to the menu.
F12: Save file as another name.
Shift+F1: Activate Money Smith point and press help.
Alt+F4: Exit Money Smith prompting user to save files.
Ctrl+F12: Open an existing Money Smith file.
Ctrl+Shift+F12: Print the active Money Smith file, graph, or report.




About Money Smith command

This command displays the title, copyright statement, author, version, registration
number and licensed user name.

Money Smith Version 1.2

Money Smith V1.2 was developed in the Spring of 1991 from scratch by Bradley J. Smith
using Borland C++ for Windows. An extensive three month beta test period followed
including at least four beta test versions and two test releases. The first version included
nearly 10,000 lines of documented C code with another few thousand lines of on-line help.
It represents the very best in shareware and many hundreds of hours of my sweat. Believe
it or not, I have a full time job as well.

Money Smith Version 3.0

Money Smith Version 3.0 took a full year to produce. It encompassed almost every
suggestion from dozens of users. Though the initial coding was completed by March of
1992, we spent several more months testing and improving upon the original baseline. |
really believe it is better than any commercial product from any company.

Dedication:
Many thanks to my wife and daughter for putting up with my long hours. This program
is dedicated to them.

| also owe so much to the registered base of users and beta testers. Without so many
positive inputs this version simply would not have been possible. Every time | felt like just
giving up | got another mail message telling me how much you liked my product. It really
kept me going. Andrea Kunz, Gary Weiderhoft, Russel Becker, Russ Stephens, Joel Staggs,
Robert Smith and Ralph Sabene were particularly outstanding in their testing of the very
earliest versions of Money Smith.

Borland C++ is a trademark of Borland International.



File Commands

Commands under the File menu:
File New command Create a new file.
File Open command Open and existing file.
File Close commandClose an open window or file.
File Save command Save current file.
File Save As command Save active window to a new file name
File Delete command Delete a file.
File Print command Set up printer.
File Printer Setup command Set up printer.
File Exit command Exit Money Smith.
File 1, 2, 3 command Directly open a previously used file.

Other menu Commands:
Command Index Index of other menu commands.




File New command

The File New command creates a new Money Smith account file and opens it for editing.
Account files are created with no accounts or transactions defined.

Procedure:
1. Choose the File New command from the menu.
2. Add new accounts and transactions as you please.

Related Topics:
File Commands Index of file commands.
File Open command Open and existing file.
File Close commandClose an open file.




File Open command

~

The File Open command opens an existing Money Smith account file and displays it using
the saved view of the account. The account is open for editing.

Procedure:

1. Choose the File Open command from the menu or choose the File Open Icon shown
above.

2. Type or select the name of the file you want to open.

3. |If the file you want is not in the current directory, type the name of the directory or
drive you want in front of the named file or select it from the directory list and press
OK.

4. Press OK or double click the selection with the mouse to open it.

5. |If the file has a password, automatic investment, or any recurring transactions

defined these may run at this time.

Related Topics:
File Commands Index of file commands.

File 1, 2, 3 command Directly open a previously used file.
Investments Editing Investments.
Recurring Transactions Recurring transactions.

Set Password Setting a password for an account.



File Close command =

The File Close command closes the existing window. If this is the main account window
and the account file has changed, you will be asked if you want to save this file before
closing. All graphs and reports associated with a main window are closed automatically by
this command.

Procedure:

1. Select the window you want to close.

2. Choose the File Close command from the menu or select the Close icon shown above
from the Windows title bar.
If you have made changes and want to save them, answer Yes to the save dialog.
If you have not assigned a name to your account you will be prompted to enter one
now.

pW

Related Topics:
File Commands Index of file commands.
File Exit command Exit Money Smith.
Window Close All command Close all open windows.
File Save command Save current file.




File Save command El

The File Save command saves the active account file using the existing file name. If no
name has been attached to this account, then the user is prompted for a name. All account
files are saved with ".ACT" extensions.

Procedure:
1. Select the account window you want to save to make it active.
2. Choose the File Save command from the menu or press the Save (floppy disk) icon on
the toolbar.
3. |If this is a new file, you will be prompted for a name to save the file as.

Related Topics:
File Commands Index of file commands.
File Save As command Save active window as another name.
File Close command Close active window.




File Save As command

The File Save As command saves the active account file allowing you to type in a new file
name. You are prompted for a name in the File Save As dialog box. All account files are
saved with ".ACT" Dos filename extension.

Procedure:

1. Select the account or report window you want to save to make it active.

2. Choose the File Save As command from the menu or press the F12 function key.

3. You will be prompted for a name to save the file as. You can either choose an
existing file (which will be overwritten by this one) or directory or type in the name of
the file you want this one saved as.

4. After running the File Save As command the active window will take the new file
name you typed and any subsequent saves will be to this new file name.

Related Topics:
File Commands Index of file commands.
File Save command Save the active window.
File Close command Close active window.




File Delete command

The File Delete command can be used to delete account files from your disk. Once
deleted a file cannot be recovered.

Procedure:

1. Choose the File Delete command from the menu.

2. Type or select the name of the file you want to delete.

3. |If the file you want is not in the current directory, type the name of the directory or
drive you want in front of the named file or select it from the directory list and press
OK.

4. Press OK or double click the selection with the mouse to delete it.

5. Answer Yes to the 'Are you sure?' message to delete the file.

Related Topics:
File Commands Index of file commands.




File Print command

The File Print command prints the active view , graph or report window on your active
printer. Colors are automatically converted to patterns for monochrome printers. You can
use the File Printer Setup command to change the printer settings.

Procedure:
1. Select the account, graph, or report window you want to print to make it active.
2. Choose the File Print command from the menu or press the printer icon on the
toolbar.
3. Fill out the Printer Preferences Dialog. The following fields are defined:

- Copies: Specifies the number of copies to print.

- Font: Select a printer font from the list.

- Pts: Lets you specify a font size in points (Note large fonts may run off the page)

- Grid: Prints a full grid between fields on the report. Slows printing.

- Title Boxes: Specifies boxes around title items. Slows printing slightly.

- Margins: You can specify margins in inches or centimeters (depending on window
setup).

3. Press OK to continue printing or Cancel to cancel the print request.
4. Press the Cancel button if you want to stop the print job, or halt it using the print
manager.

Related Topics:
File Commands Index of file commands.
File Printer Setup command Set up printer.
File Save As command Save active window to a file.




File Printer Setup command

The File Printer Setup command lets you set the current printer and access your printer
setup dialog. You can use the File Print command to print Money Smith windows and

reports.

Procedure:
1. Select the File Printer Setup command from the menu.

2. Select the printer you want to make active.
3. Press OK to make this the current printer.
4. Press the Setup button if you want to change any printer settings.

Related Topics:
File Commands Index of file commands.

File Print command Set up printer.




File Exit command

The File Exit command closes all existing windows and exits the Money Smith program.
Before exiting each the user is asked to save each account file if changes have been made.
Current graphs and reports are closed automatically by this command.

Procedure:
1. Choose the File Exit command from the menu.
2. If you have made changes and want to save them, answer Yes to the save dialog.
3. If you have not assigned a name to an account file you will be prompted to enter one
now.

Related Topics:
File Commands Index of file commands.
File Close command Close current window.
Window Close All command Close all open windows.




File 1,2,3... command

The File 1,2,3... command opens an recently used Money Smith account file and displays
it using the saved view of the account. The account is open for editing.

Procedure:
1. Choose the numbered file you want to open from the File menu.
2. |If the file has a password, automatic investment, or any recurring transactions
defined these may run at this time.

Related Topics:
File Commands Index of file commands.
File Open command Open an existing file.
File New command Create a new file.
File Close command Close an open file.




Edit Commands

Commands under the Edit menu:
Edit Cut command Cut an account or transaction to clipboard.
Edit Copy command Copy an account or transaction to clipboard.
Edit Paste command Paste an account or transaction from clipboard.
Edit Copy Report command Copy the entire report to the clipboard.
Edit Add command Add a new account or transaction.
Edit Edit command Edit the current account or transaction.
Edit Import Transactions command Import transactions.
Edit Find command Locate transaction or account.

Other menu Commands:
Command Index Index of other menu commands.




Edit Cut command o+

The Edit Cut command cuts the currently selected account or transaction to the
clipboard. The current account or transaction is deleted from the active window. Cut items
may be pasted to this or another account window. Note that investment transactions
cannot be pasted - they are discarded when cut.

Procedure:
1. Select the account or transaction you want to cut.
2. Choose the Edit Cut command from the menu or press the cut (scissors) icon on the
toolbar.
3. Answer Yes when asked if you are sure you want this item cut.

Warnings:
You must be in an account view or report to cut an account.
You must be in a transaction view or report to cut a transaction.
You must be in an investment report to cut an investment.
You cannot delete an account that still has transactions defined against it.
You cannot paste an investment transaction.

Related Topics:
Edit Commands Other edit menu commands.
Edit Copy command Copy an account or transaction to clipboard.
Edit Paste command Paste an account or transaction from clipboard.




Edit Copy command

The Edit Copy command copies the currently selected graph, account or transaction to
the clipboard. Copied accounts and transactions may be pasted to this or another account
window. You can paste graphs into any graphics tool like paint. Note you cannot copy or
paste investment transactions.

Procedure:
1. Select the graph window, account or transaction you want to copy.
2. Choose the Edit Copy command from the menu.

Warnings:
You must be in an account view to copy an account.
You must be in a transaction view to copy a transaction.
You cannot copy or paste investment transactions.

Related Topics:
Edit Commands Other edit menu commands.
Edit Cut command Cut an account or transaction to clipboard.
Edit Paste command Paste an account or transaction from clipboard.




Edit Paste command

The Edit Paste command copies an account or transaction from the clipboard to the
currently active account.

Procedure:
1. Cut or copy a transaction using the Edit Copy command .
2. Select the account or transaction view or report you want to paste this item into.
3. Choose the Edit Paste command from the menu.

Warnings:
You must be in an account view or report to paste an account. Account names must
be unique.
You must be in a transaction view or report to paste a transaction. Transactions are tied
to unique account id's and may not move easily from one account file to another.

Related Topics:
Edit Commands Other edit menu commands.
Edit Cut command Cut an account or transaction to clipboard.
Edit Copy command Copy an account or transaction to the clipboard.




Edit Add command +

The Edit Add command adds a new account, transaction or investment transaction to
the currently active account window.

Procedure:
1. Select the account or transaction view or report you desire.
2. Choose the Edit Add command from the menu or select the add (large '+') icon on the
toolbar.
3. Edit the Account Dialog or Transaction Dialog. or Investment transaction dialog.
4. Press the Save button to save the account or the Another button to save the account
and create another.

Warnings:
You must be in the appropriate view or report (investment, account, transaction) to add.

Related Topics:
Edit Commands Other edit menu commands.
Account Dialog Description of the account editing dialog.
Edit Edit command Edit the current account or transaction.




Edit Edit command &

The Edit Edit command edits the current account, transaction, or investment

transaction.

Procedure:
1. Select the account or transaction using arrow keys or the mouse.

2. Choose the Edit Edit command from the menu.
OR select the edit (magnifying glass) icon from the toolbar

OR double click the current account or transaction
OR select the small edit (magnifying glass) icon next to the item you want to edit.

3. Edit the Account Dialog or Transaction Dialog.
4. Press the Save button to save the changes. Press the Cancel button to throw changes

away.

Related Topics:
Edit Commands Other edit menu commands.
Account Dialog Description of the account editing dialog.
Joolbar The Money Smith toolbar.
Edit Add command Add a new account or transaction.




Edit Copy Report command

The Edit Copy report command copies the entire current Report , View , or Graph to the
clipboard where it can be pasted into other applications.

Procedure:

1. Make the window you wish to copy active with the mouse.

2. Choose the Edit Copy Report command from the menu.

3. If you are copying a report you will be prompted for the format. Table format is
suitable for spreadsheets while text format is used for word processors and other
applications.

4. Paste the report or graph into another application using its paste command.

Related Topics:
Edit Commands Other edit menu commands.
Edit Copy command Copy an account, transaction or graph.
Edit Edit command Edit the current account or transaction.




Edit Import Transactions command

The Edit Import Transactions command imports transactions from an external source into
the Money Smith transaction system. Transactions must be in a specific format as described
below.

Procedure:
1. Copy transactions to the clipboard from your spreadsheet, notepad, word processor, or
other source in the exact format described below.
2. Choose the Edit Import Transactions command from the menu.
3. If there are any errors, you will be prompted to either continue or cancel the
importation of remaining transactions.

Data Description:

The data to be imported must have the following fields in each record in order, with one
record per line to be correctly parsed and inserted as transactions. Individual fields
may be separated by a tab, comma, or pipe symbol character.

Date: Date in the format MM/DD/YY (or variations for international dates).

Number: Check number for the transaction.

Description: Description/Payee field for the transaction.

To: To account for this transaction. This should be a valid account name.

From: From account for this transaction. This should be a valid account name.

X: Field marked with a capital X if this is a cleared transaction, or a space if not cleared.

Amount: The amount for this transaction. This should be a number preferrably without
currency signs.

Notes: A notes field with notes to be attached to this transaction.

Related Topics:
Edit Commands Other edit menu commands.
Edit Copy Report command Copy a report.




Edit Find command

The Edit Find command searches the current report for a given piece of text, and moves
the cursor to that location when found. Only selectable accounts or transactions are
searched.

Procedure:
1. Choose the Edit Find command.
2. When the Find dialog is displayed, enter the text or number you wish to search for.
You may select the forward button to search forward, or the backward button to
search back from the current selection.

Related Topics:
Edit Commands Other edit menu commands.




View Commands

Commands under the View menu:
View Account command View account list.
View Transaction command View current transactions.
View Toolbar command Toggle Toolbar on and off.
View Statusbar command Toggle Statusbar on and off.
View Grid command Toggle grid lines on and off.

Other menu Commands:
Command Index Index of other menu commands.




TS
View Account command Q

The View Account command displays a list of all current accounts and their balances in
the account window. Accounts are sorted by type. The account view, like all views is an

Interactive Window. You can perform a variety of functions from the window described
below:

Title bar:
W oem | Accounts
Cloze Box J |—Transacti|:|n Wiew ]— Mew Account

| 341192 | 33192 | Category
Change Date J Edit Categaries
Type bars:

Assets! 548,100.70 - Either Asset, Liability, Income, Equity, or Expense totals. Press here for a
pie graph.

Fields:
| Sl
.":".CCI:ILIr'It]J 4 | vestment
Fiegister Edit

Name: Name of the account.
Dates: Balance of accounts as of these starting and ending dates.
Category: Category account is assigned to.

Procedure:

1. Choose the View Account command from the menu or choose the view accounts (eye
over checkbook) icon on the Toolbar .

Related Topics:
View Commands Other View Commands.
View Transaction command View current transactions.
Report Current Account Register command View current account's transactions.
View Grid command Toggle grid lines on and off.
Options Date command Change the currently viewable date.




View Transaction command E?

The View Transaction command displays a list of current transactions in the current
account window. Only transactions that fall within the current accounting dates are
displayed. You can perform a variety of functions from this Interactive Window.

Title bar:
Account View
wes Date | # | Transaction | || (X
Cloze Change D ate Mew Tranzaction bark Tuact
Fields:

Date: Date of the transaction.

# : Check number of the transaction.
Transaction: Description of the transaction.
To: Account transaction moves money to.
From: Account transaction moves money from.
X: Check is cleared - Press to toggle.

Amount: Dollar amount of the transaction.

Procedure:
1. Choose the View Transactions command from the menu or choose the transaction
view icon (eye over dollar sign) on the Toolbar .

Related Topics:
View Commands Other View Commands.
Report Current Account Register command View current account's transactions.
Options Date command Change the currently viewable dates.




View Toolbar command

The View Toolbar command toggles the display of the Money Smith toolbar. The toolbar
places frequently used menu commands on individual pushbuttons for easier use.

Description:
Press the corresponding toolbar button with the mouse to perform these functions.

-Money Smith interactive help - just press this button and press the item you want help

- Open a Money Smith file.
- Save the current file.

- Print the active window.

- Add a new account or transaction.

(@]

ut the currently selected account or transaction.

g |

- Edit the selected account or transaction.

- Find text in the current account or transaction report.

- Switch to Account View

- Switch to Transaction View

>

dd a new account.

e+ | 2 [ ) () L) )

>

dd a new transaction.

=
ra
=

- Sets the currently viewable dates.

previously defined investment accounts.

m m
o Q.
=~ |
n i

-
I
=
1

recurring transactions.

- Money Smith Financial Calculator.

- Balance Sheet Report.

- Income Report

JSElEN ]

- Asset Graph.

=
Q - History of current Account Graph.

b History of current Investment Graph.

&
ﬂ - History of Assets, Etc.. Graph

Procedure:
1. Choose the View Toolbar command to toggle the toolbar on and off.
2. Choose the appropriate icon to perform that function.



Related Topics:
View Commands Other View Commands.




View Statusbar command

The View Statusbar command toggles the display of the Money Smith status bar. The

status bar displays expanded menu commands and other pertinent information at the
bottom of the Money Smith window.

Procedure:
1. Choose the View Statusbar command to toggle the status bar on and off.

Related Topics:
View Commands Other View Commands.




View Grid command

The View Grid command toggles the display of Grid lines in various account views. Grid
lines make accounts more viewable, but slow printing.

Procedure:
1. Choose the View Grid command to toggle the grid on and off.

Related Topics:
View Commands Other View Commands.




Options Commands

Commands under the Options menu:
Options Date command Change the currently viewable date.
Options Preferences Set Money Smith preferences.
Options Report Title command Set the title for graphs and reports.
Options Password command Set or reset password for account.

Other menu Commands:
Command Index Index of other menu commands.




Options Date command EI

The Options Date command lets you change the start and end dates used to calculate
and display all balances, accounts, transactions, reports, and graphs. Only transactions
between the starting and ending dates are displayed in transaction or register views. You
can change the current date which helps in adding old transactions.

Procedure:
1. Choose the Options Date command or press the date (calendar page) icon on the
toolbar.
2. Fill out the starting date, end date, and current date.
3. All account balances, transactions, graphs, and reports will automatically reflect the
new dates.

Related Topics:
Options Commands Other Options Commands.



Options Preferences command

The Options Preferences command lets you change a number of startup and runtime
options to configure Money Smith as you like. Each preference is saved in the smith.ini
configuration file when you exit Money Smith. Once a preference is changed it will remain
in effect until changed again.

Procedure:
1. Choose the Options Preferences command.
2. Change the preferences as you like.
3. Press OK to save the changes, or press Cancel to discard them.

Description of Options:

Display Options:
Horiz Scroll: Toggles the horizontal scroll bar at the bottom of each view and report.
Grid Lines: Toggles display of grid lines to separate fields on reports.
Toolbar: Toggles display of the graphical toolbar.
Status Bar: Toggles display of the status bar.

International Currency Options:
Money Smith supports full international currency and date formats. Set the currency
by selecting the international icon from the Windows Control Panel.

Transaction Entry Options:
Transaction Style: Corresponds to simple to/from accounting as used in Money Smith
version 1.2.
Check Style: New check style format that many users find easier to deal with. Allows
easy deposits and withdrawls from an account.

Window Size Options:
Full Screen: Money Smith will be maximized on startup.
Last Size: Money Smith resumes the size and position that was last used.

Open File Options:
Open No File: No files are opened on startup.
Open File Command: A File Open command is issued on startup.
Open File: The file name in the edit box is opend when Money Smith starts.
Create Backup: Creates a backup of each file on opening (file.BAK).

Start Date Options:
1st of Month: The default accounting start date is the first of the current month.
1st of Year: The default accounting start date is the first of the current year.

End Date Options:
End of Month: The default accounting end date is the end of the current month.
Today: The default accounting end date is today.

Related Topics:
Options Commands Other Options Commands.




Options Report Title command

The Options Report Title command sets or changes the title that appears at the top of all
of the reports and graphs for this account file. The title is saved with the account file.

Procedure:
1. Choose the Options Report Title command from the menu.
2. Enter the new report title string.
3. Press OK to save the change, or Cancel to forget it.

Related Topics:
Options Commands Other Options Commands.
Report Commands Report Commands.



Options Password command

The Options Password command sets or changes your password. Please don't forget
your password since you cannot open an acount file that has a password without it.

Procedure:
1. Choose the Options Password command from the menu.
2. To change: enter your old and new passwords.
3. To Set: enter your new password.
4. To Unset: enter your old password, leave the new password fields blank.

Related Topics:
Options Commands Other Options Commands.



Report Commands

Commands under the Report menu:
Report Balance Statement command Create a balance report window.
Report Income Statement command Create an income report window.
Report Budget Report command Create a budget report window.
Report Account Inflow/Outflow command Account flow report window.
Report Tax Summary command Create a tax summary report window.
Report Category command Create a balance report window.

Report Category Balance Statement command Balance statement by category.
Report Category Income Statement command Income statement by category.
Report Current Account Register command Display this accounts transaction register.

Report Reconcile Current Account command Create a reconciliation report.
Report Cash Flow for Current Account command Display account's inflows/outflows.

Report Current Investment command Create a current investment window.

Other menu Commands:
Command Index Index of other menu commands.




Report Balance Statement command EI

The Report Balance Statement command creates a new Money Smith report window and
opens it for viewing. The balance statement totals your current assets, liabilities, and
equity, to compute you net equity which is the same as your net worth. All balances are
computed as of the end of the current accounting dates.

Description:
Name: Shows the name of each account.
Balance: Shows the current account balance in dollars.
Percent: Shows the percentage this account is relative to total assets, liabilities, or

equity.
Procedure:
1. Choose the Report Balance Statement command from the menu or press the balance
icon.

Related Topics:
Report Commands Other Reports.

Report Income Statement command Create an income report window.




Report Income Statement command El

The Report Income Statement command creates a new Money Smith report window and
opens it for viewing. The income statement totals your income and expenses for the
current accounting dates and displays your net income (income minus expenses).

Description:
Name: Shows the name of each account.
Balance: Shows the total income or expense in dollars.
Percent: Shows the percentage this account is relative to total income or expenses.

Procedure:
1. Choose the Report Income Statement command from the menu or press the income

(dollar sign going into safe) icon.

Related Topics:
Report Commands Other Reports.

Report Balance Statement command Create a balance report window.




Report Budget Report command

The Report Budget Report command creates a new Money Smith report window and
opens it for viewing. The budget report compares actual to budgeted income and
expenses for the current accounting period and shows the percent difference between them.
Budgets can be set for each income and expense account using the Edit Add command from
account view ort pressing the '+' button on the toolbar. Totals are displayed below income
and expense accounts.

Description:
Name: Shows the name of each account.
Budget: Shows the budget set for the account in dollars.
Actual: Shows the actual income or expenses for the account in dollars.
Difference: Shows the difference between budgeted and actual income and expense.
Percent: Shows the percentage difference between actual and budgeted values.

Procedure:
1. Choose the Report Budget Report command from the menu.

Related Topics:
Report Commands Other Reports.




Report Account Inflow/Outflow

The Report Account Inflow/Outflow command creates a new Money Smith report window
and opens it for viewing. The Account Inflow/Outflow report compares the starting and
ending balances for each account for the current accounting period and shows the percent
difference between them. This shows the net change in that account for the period.

Description:
Accounts: Shows the name of each account.
Dates: Shows the starting and ending balances.
Change: Shows the difference between starting and ending balances for each account.
% Change: Shows the percentage difference between each account's starting and
ending balances.

Procedure:
1. Choose the Account Inflow/Outflow command from the Report menu.

Related Topics:
Report Commands Other Reports.




Report Tax Summary command

The Report Tax Summary command creates a new Money Smith report window and
opens it for viewing. The report shows taxable and non-taxable income and expenses for
the current accounting period and shows the percentage of totals. Totals for both taxable
and non-taxable income and expenses are shown below the accounts in each category.

Description:
Name: Shows the name of each account.
Balance: Shows the actual income or expenses for the account in dollars.
Percent: Shows the percentage of taxable or non-taxable income or expense.

Procedure:
1. Choose the Report Tax Summary command from the menu.

Related Topics:
Report Commands Other Reports.




Report Current Account Register command }

The Report Current Account Register command displays a list of transactions that involve
the current account.Only transactions that fall within the current accounting dates and affect

the current account are displayed.

Description:
Date: Date of the transaction.
# : Check number of the transaction.
Transaction: Description of the transaction.
To/From: Account this transaction is moving money to or from.
Amount: Dollar amount of the transaction.
Balance: Balance of the current account after this transaction.

Procedure:
1. Choose the Report Current Account Register command from the menu or choose the

button to the left of the account you wish to view .

Related Topics:
Report Commands Other Reports.
View Account command View account balances.
View Transactions command View all current transactions.

Options Date command Change the currently viewable dates.




Report Reconcile Account command

The Report Reconcile Account command creates a new Money Smith report window and
opens it for viewing. The report shows a list of all transactions for the current account
within the accounting period and prints running balances of cleared transactions (marked
with an X) and uncleared transactions. Transactions are listed in sorted order with deposits
and withdrawls sorted by check number. By correcting cleared flags and comparing with
your bank statement for the account you should be able to balance your account easily.

Description:
Date: Shows the date of each transaction.
Description: Shows the description of each transaction.
Amount: Shows the amount of the transaction in dollars.
X: Marked with an X if this transaction is cleared. Press to toggle flag.
Un-Cleared: Running balance including only transactions that have not cleared.
Balance: Running balance including all transactions that have cleared

Procedure:
1. Choose the Report Reconcile Account command from the menu.
2. Clear transactions as appropriate.

Related Topics:
Report Commands Other Reports.




Report Category Report command

The Report Category Report command creates a new Money Smith report window and
opens it for viewing. The report shows a list of all accounts assigned to categories with
balance totals and percentages for each category.

Description: